LENESAS APPLICATION NOTE

RZ/T2M Group

Example of separating loader program and application program projects

Introduction

This application note explains a sample application separating the application into a loader program and an
application program.

The maijor features of the sample program are listed below.

e The program supports two operating modes of the device: xSPI0 boot mode (x1 boot serial flash)
version and 16-bit bus boot mode (NOR flash) version.

e The sample application consists of two separated projects, the loader program and the application
program.

e The loader program is a program for copying the application program from external flash to internal
RAM or external RAM. This is done according to the loader table information (source address,
destination address, size) defined in the loader program.

e The application program is ,copied and started by the loader program. It performs initial settings and
let the LEDs blink.

Target Devices
RZ/T2M Group

When applying the sample program covered in this application note to another microcomputer, modify the
program according to the specifications for the target microcomputer and conduct an extensive evaluation
and testing of the modified program.
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RZ/T2M Group  Example of separating loader program and application program projects

1. Specifications
1.1 Operating Environment

The sample program covered in this application note is for the environment below.

Table 1.1

Operating Environment

Iltem

Description

Microcomputer

RZ/T2M Group (R9A07G075M28GBG)

Operating Frequency

CPU core0: 800MHz (Arm® Cortex®-R52)
CPU core1: 800MHz (Arm® Cortex®-R52)"

Operating Voltage

3.3V/1.8V/1.1V

Integrated Development Environment

e Embedded Workbench® for Arm Version 9.50.1
from IAR systems

o ¢e?studio 2024-01.1 (24.1.1) (R20240125-1623)
from Renesas

Operating mode

e xSPI0 boot mode (x1 serial flash)
e 16-bit bus boot mode (NOR flash)

Board

Renesas Starter Kit+ for RZ/T2M

Flexible Software Package (FSP)

Version 2.0.0 (RZ/T2 FSP)

Note 1. When using CPU core1, refer to "5.3 How to Debug CPU1 Program".

RO1ANG6729EJ0210 Rev.2.10
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1.2 File Structure
The details of the file structure and contents of this package are show below.

RZT2M_loader_application
F—r01an6729jj0210-rzt2m.pdf
F—r01an6729ej0210-rzt2m.pdf
—iccarm: for EWARM

—16bitbusboot: sample program for NOR flash
| —Loader_application_projects
| —application: project for application program
| —loader: project for loader program
| —cpu1: project for CPU1 program
| L—RZT2M bsp_16bitbusboot_app_loader.eww: EWARM workspace
L—xspiObootx1: sample program for SPI flash
L—| oader_application_projects
—application: project for application program
—loader: project for loader program
—cpu1: project for CPU1 program
L—RZT2M_bsp_xspiObootx1_app_loader.eww: EWARM workspace

L—gcc : for €2 studio

—16bitbusboot: sample program for NOR flash
|  “—Loader_application_projects.zip
| F—RZT2M_bsp_16bitbusboot_app: project for application program
| F—RZT2M_bsp_16bitbusboot_loader: project for loader program
| L—RZT2M_cpu1: project for CPU1 program
L—xspiObootx1: sample program for SPI flash
L—L oader_application_projects.zip
F—RZT2M_bsp_xspiObootx1_app: project for application program
F—RZT2M_bsp_xspiObootx1_loader: project for loader program
L—RZT2M_cpu1: project for CPU1 program

The files of the package are separated to EWARM and e2 studio environment at first level, and to NOR
flash and SPI flash at second level.

Each of the six resulting sample application consists of two projects — one project for the loader program ,
one project for the application program and one project for the CPU1 program.

For the usage procedures of sample program in each development environments, see Appendix
Supplementary Notes on Development Environments.

RO1AN6729EJ0210 Rev.2.10
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1.3 Switch and Jumper Settings

The switch and jumper settings required to run the sample program are shown below. For details on each
setting, see the Renesas Starter Kit+ for RZ/T2M User’s Manual.

Table 1.2 Switch settings

Project SW4-1 SW4-2 SwW4-3 SW4-4 SW4-5 SW6-1
16-bit bus boot mode ON OFF ON ON OFF ON
xSPI0 boot mode ON ON ON ON OFF -
Table 1.3 Jumper settings

Project CN8 CN17

16-bit bus boot mode - Short 1-2

xSPI0 boot mode Short 2-3 -
RO1AN6729EJ0210 Rev.2.10 Page 5 of 45
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2. Hardware
2.1 Peripheral Functions

Table 2.1 lists the peripheral functions to be used and their applications.

Table 2.1 Peripheral functions and applications

Peripheral function

Application

Clock generation circuit (CGC)

Used as a CPU clock and each peripheral module
clock

Interrupt controller (ICU)

Used for software interrupts (INTCPUOQ)

Bus state controller (BSC)

Used to attach NOR flash memory to CS0 space

Expanded serial peripheral interface (xSPI)

Used to attach Serial flash memory to external
address space xSPI0

General purpose I/O ports

Used to control pins to light LEDs on and off

See the RZ/T2M Group User's Manual: Hardware for basic descriptions.

RO1ANG6729EJ0210 Rev.2.10
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2.2 Pins
Table 2.2 lists pins to be used and their functions.

Table 2.2 Pins and Functions

Pin Name Input/Output Function
A1 to A25 Output Address signal output to NOR flash memory
DO to D15 Input/Output | Data signal input and output to NOR flash memory
CSOo# Output Device selection signal output to NOR flash memory attached to CSO space
RD# Output Strobe signal output indicating reading
WEO#/DQMLL Output Write strobe signal output to D15 to D8
WE1#/DQMLU Output Write strobe signal output to D7 to DO
XSPI0_CKP Output Clock output
XSPI0_CS0 Output Device selection signal output to QSPI flash memory attached to CS0O space
XSPI0O_RESETO Output Master reset status output
XSPI0_IO0 ~ Input/Output | Data input / output
XSPIO_IO3
MDO Input Operating mode selection:
MD1 Input e MDO ="L", MD1 = “L”, MD2 = “L” (xSPI0 boot mode)
MD2 Input e MDO =“L", MD1 = “H", MD2 = “L” (16-bit bus boot mode)
P19_6 Output Lighting LEDO on and off
P19_4 Output Lighting LED1 on and off
P20_0 Output Lighting LED2 on and off
P23 4 Output Lighting LED3 on and off

Note: The mark "#" indicates negative logic (or active low).

R0O1AN6729EJ0210 Rev.2.10 Page 7 of 45
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3. Software
This section explains the case of EWARM (from IAR systems) unless otherwise stated.

In this document, the program included in the loader project is called loader program, and the program
included in the application project is called application program. Loader program and application program
each have startup processing section and main processing section.

3.1 Operation Overview

After the reset is released, the loader program for each operating mode (16-bit bus boot/xSPI0 boot) stored
on the external flash memory (NOR flash/Serial flash) is copied to the internal RAM (BTCM).

After boot processing, the loader program is executed. The loader program copies the application program
from external flash memory (NOR flash/Serial flash) to RAM (System SRAM). As final step of the loader
program the entry point of the copied application program is called. After executing the loader program, the
execution of the application program starts.

Storage area Execution area
BTCM
External flash memory
Loader program
Loader program 1
System SRAM
Application
program 2 Application
program

1. After reset release, copy the loader program from external flash memory to
BTCM in boot proccessing.

2. Copy the application program from external flash memory to System
SRAM in loader program processing.

Figure 3.1  Operation overview
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3.1.1 Loader Program

The loader program performs initial settings such as changing the exception level and setting the clock as
startup processing. Then the main processing is executed. In the main processing, the application
program stored in external flash (NOR flash/Serial flash) memory is copied to RAM (System SRAM)
according to parameters of loader table. The loader table is a table that the loader program references
when copying the application program. For details on the loader table, see 3.2 Loader Table.

In addition, LEDO turns on to signal the start of copy processing, and LED3 turns on to signal the end of
copy processing. After copy process is complete, the application program is executed.

Figure 3.2 shows operation overview of loader program.

< Start loader program >

Set EL1 exception vector table offset

Return from EL2 to EL1

Initialize stack, FPU, clock, variable, etc

Turn on LEDO

Copy the application program
according to loader table.

Turn on LED3

< Branch to application program >

Figure 3.2  Operation overview of loader program
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3.1.2 Application Program
The application program performs initial settings such as clock settings, port initialization, and interrupt
settings as startup processing. LEDO and LED3, which turned on during loader program processing, turn
off in port initialization. Then the main processing is executed.
The main processing executed on System SRAM let the LEDs blink.
The LED blinking process is executed by software interrupt (INTCPUQ), and LEDO and LED1 blink.
Figure 3.3 shows operation overview of application program.

< Start application program >

Set EL1 exception vector table offset

Initialize stack, FPU, clock, variable, etc

< Start software interrupt processinD
CPU MPU, cache, port, Master MPU,

interrupt settings, etc Enable port access

Software interrupt (INTCPUO) setting Turn on/off LEDO and LED1

P
w

Disable port access

(Finish software interrupt processirD

Generate software interrupt (INTCPUO)

Software delay

Figure 3.3  Operation overview of application program

R0O1AN6729EJ0210 Rev.2.10 Page 10 of 45
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3.2 Loader Table

Loader table is a table that the loader program references when copying the application program. The loader
table defines the parameters required for program copy, and the loader program performs copy processing
according to the table parameters. Multiple loader table entries can be prepared as required, and parameters

can be stored in each table entry.

The loader table has four parameters: copy source address, copy destination address, copy size, and table
enable/disable flag. Table 3.1 shows the details of the loader table parameters.

In this sample program, four loader tables are prepared in loader_table.c of the loader program. The copy
source address depends on the boot operating mode. Tables 3.2 and 3.3 show the loader table parameters
in this sample program.

Table 3.1 Loader table parameters

Argument | Parameter

Description

1 Src Source address of the program to be copied.
2 Dst Destination address of the program to be copied.
3 Size Size of the program to be copied.
4 Enable flag Flag that determines whether the table is enabled/disabled.
If this flag is disabled, copy processing will not be performed even if other
parameters are set.
0: Disable
1: Enable
Table 3.2 Loader table parameters in this sample program (xSPI0 boot mode)
Table Src Dst Size Enable flag
0 0x6010_0000 0x1008_0000 0x0000_22AC 0x1
17172 OxFFFF_FFFF OxFFFF_FFFF OxFFFF_FFFF 0x0
or or or or
0x6020_0000 0x1000_0000 0x0000_1014 0x1
21 OxFFFF_FFFF OxFFFF_FFFF OxFFFF_FFFF 0x0
31 OxFFFF_FFFF OxFFFF_FFFF OxFFFF_FFFF 0x0
Note 1. Table 1,2, and 3 are invalid in this sample program.
2. When CPU1 program is enabled, Table1 hold the parameters for CPU1 program. For details,
see”5.3 How to Debug CPU1 Program”.
Table 3.3 Loader table parameters in this sample program (16-bit bus boot mode)
Table Src Dst Size Enable flag
0 0x7010_0000 0x1008_0000 0x0000_22EC 0x1
1 OxFFFF_FFFF OxFFFF_FFFF OxFFFF_FFFF 0x0
or or or or
0x7018_0000 0x1000_0000 0x0000_OEBC 0x1
2 OxFFFF_FFFF OxFFFF_FFFF OxFFFF_FFFF 0x0
3 OxFFFF_FFFF OxFFFF_FFFF OxFFFF_FFFF 0x0
Note 1. Table 1,2, and 3 are invalid in this sample program.

2. When CPU1 program is enabled, Table1 hold the parameters for CPU1 program. For details,
see”5.3 How to Debug CPU1 Program”.

RO1AN6729EJ0210 Rev.2.10
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3.3 Memory Map
3.3.1 Program Placement i

n Flash Memory

Tables 3.4 and 3.5 show the program placed in the flash memory of this sample program. Flash memory
address depends on the operating mode. At the start of debugging, the program is downloaded to flash

memory. Each program is copied to the load destination address by boot processing and loader program
processing and executed on RAM.

Table 3.4 Program placement in flash memory and load destination address (xSPI10 boot mode)

Flash memory address

Contents

Load destination address

0x6000_0000

Parameters for the loader

0x6000_004C

Loader program

0x0010_2000 (BTCM)

0x6008_0000

Loader table

0x6010_0000

Application program

0x1008_0000 (System SRAM)

0x6020_0000"

CPU1 program

0x1000_0000 (System SRAM)

Note 1. CPU1 program is disabled by default. To enable it, see “5.3 How to Debug CPU1 Program”.

Table 3.5

Program placement in flash memory and load destination address (16-bit bus boot mode)

Flash memory address

Contents

Load destination address

0x7000_0000

Parameters for the loader

0x7000_004C

Loader program

0x0010_2000 (BTCM)

0x7008_0000

Loader table

0x7010_0000

Application program

0x1008_0000 (System SRAM)

0x7018_0000

CPU1 program

0x1000_0000 (System SRAM)

Note 1. CPU1 program is disabled by default. To enable it, see “5.3 How to Debug CPU1 Program”.

RO1ANG6729EJ0210 Rev.2.10
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3.3.2 Section Assignment in Sample Program

Table 3.6 shows the memory sections used by the loader program, and Table 3.7 shows the sections
used by the application program. These sections are defined in the linker script.

Table 3.6 Sections used by loader program

Area Name Description Storing/Execution
Area™

LOADER_PARAM_BLOCK Parameters for the loader Flash
PRG_RBLOCK Code area (for storing) Flash

USER _DATA_RBLOCK Variable area (for storing) Flash
PRG_WBLOCK Code area (for execution) BTCM
USER_DATA_WBLOCK Variable with initial value area (for execution) BTCM

USER _DATA_ZBLOCK Variable without initial value area (for execution) | BTCM
APPLICATION_PRG_RBLOCK | Application program area (for storing) Flash
APPLICATION_PRG_WBLOCK | Application program area (for executing) System SRAM
CPU1_PRG_RBLOCK™ CPU1 program area (for storing) Flash
CPU1_PRG_WBLOCK™ CPU1 program area (for execution) System SRAM

Note
memory is storing area.

1. In xSPIO bus boot, serial flash memory is storing area. In 16-bit bus boot mode, NOR flash

2. CPU1 program is disabled by default. To enable it, see “5.3 How to Debug CPU1 Program”.

Table 3.7 Sections used by application program

Area name Description Storing/Execution
Area™
PRG_RBLOCK Code area (for storing) Flash
USER_DATA_RBLOCK Variable area (for storing) Flash
PRG_WBLOCK Code area (for execution) System SRAM
USER _DATA_WBLOCK Variable with initial value area (for execution) System SRAM
USER _DATA_ZBLOCK Variable without initial value area (for execution) System SRAM

Note

1. In xSPIO bus boot, serial flash memory is storing area. In 16-bit bus boot mode, NOR flash
memory is storing area.

RO1ANG6729EJ0210 Rev.2.10
Jun.16.25
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3.3.3 CPU MPU Settings

Table 3.8 shows the CPU MPU settings for areas accessed by CPU in this sample program. These
setting are applied during startup processing of the application program.

Table 3.8 CPU MPU Settings

0x1017_FFFF

Contents Address Memory type
System SRAM 0x1000_0000 | Area2
to Normal, cache enabled, non-shared

System SRAM (mirror area)

0x3000_0000
to
0x3017_FFFF

Area 4
Normal, cache disabled, shared

Extended address space (mirror
area)

xSPI0, xSPI1

CS0, CS2, CS3, CS5

0x4000_0000
to
Ox5FFF_FFFF

Area 5
Normal, cache disabled, shared

Extended address space
xSPI0, xSPI1
CS0, CS2, CS3, CSs5

0x6000_0000
to
Ox7FFF_FFFF

Area 6
Normal, cache enabled, non-shared

Non-safety peripheral modules

0x8000_0000
to
Ox80FF_FFFF

Area 7
Device (nGnRE), instruction fetch disabled

Safety peripheral modules

0x8100_0000
to
O0x81FF_FFFF

Area 8
Device (hnGnRE) , instruction fetch disabled

3.3.4 Exception Processing Vector Table
Exception level 1 of RZ/T2M has 7 types of exception processing (reset, undefined instruction, SVC,
prefetch abort, Data abort, IRQ and FIQ exceptions) that are allocated to the 32-byte area starting from
specified offset address. Specify a branch instruction to each exception processing in the exception

processing vector table.

Table 3.9 lists the contents of exceptional processing vector table for this sample program. Modify the

setting to suit your needs.

Table 3.9  Exception Processing Vector Table
Exception Handler Address*1 Remark*2
RESET Offset Branches to startup program
Undefined instruction Offset + 0x0000 00004 Branches Defaul _Handler
SvC Offset + 0x0000 00008 Branches Defaul_Handler

Prefetch abort

Offset + 0x0000 0000C

Branches Defaul_Handler

Data abort Offset + 0x0000 00010 Branches Defaul_Handler
Reserved Offset + 0x0000 00014 Branches Defaul_Handler
IRQ Offset + 0x0000 00018 Branches IRQ_Handler (Used for interrupt)
FlQ Offset + 0x0000 0001C Branches Defaul_Handler

Note 1. The offset is defined as following.

Loader program
Application program
CPU1 program

: 0x0010_2000
: 0x1008_0000
: 0x1000_0000

2. Software break instruction is executed in Default_Handler.

RO1ANG6729EJ0210 Rev.2.10
Jun.16.25
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3.4 Function Specifications
This section describes the function specifications.

3.4.1 system_init
system_init
Overview System initialization 1.
Declaration void system_init (void)
Description Executes system initialization such as setting the exception handling vector table
offset and changing Exception Level to 1 from 2. After that, branches to stack_init.
Arguments None
Return value None
Remarks After boot processing, this function runs as startup process.

3.4.2 stack_init

stack_init
Overview System initialization 2.

Declaration void stack_init (void)

Description Executes system initialization such as initializing the stacks, FPU, clock, variables
for startup process, CPU MPU, cache, and ports. After that, branches to the main
process.

Arguments None

Return value None
Remarks None

3.4.3 hal_entry

hal_entry
Overview Main process.

Declaration void hal_entry (void)

Description e Loader program: Copies the application program to internal RAM. Turns on
LEDO before copy processing and turns on LED3 after copy processig is
complete.

e Application program: Blinks LEDO and LED1 with software interrupt (INTCPUO).

Arguments None

Return value None
Remarks None

RO1AN6729EJ0210 Rev.2.10

Jun.16.25

Page 15 of 45
RENESAS



RZ/T2M Group  Example of separating loader program and application program projects

3.4.4 bsp_copy_multibyte
bsp_copy_multibyte

Overview Copy function.
Declaration void bsp_copy_multibyte (uintptr_t *src, uintptr_t *dst, uintptr_t bytesize)
Description Copies data for the size specified by the argument.
Arguments e uintptr_t *src: Copy source address.

e uintptr_t *dst: Copy destination address.
e uintptr_t bytesize: Copy data size.

Return value None
Remarks None
RO1AN6729EJ0210 Rev.2.10 Page 16 of 45
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3.5 Flowchart

3.5.1 Loader Program
3.5.1.1 system_init

Figure 3.4 shows flowchart of system_init in the loader program.

< system_init >

EL2 initialization

Initialize in EL2.

EL1 exception vector table offset
setting

Set the offset of the exception vector table used
in the loader program.

LLPP permission setting

Enable LLPP access.

Return from EL2 to EL1

Save CPSR and move to EL1 with ERET instruction.

( stack_init > Branch to stack_init.

Figure 3.4

system_init processing (loader program)

RO1ANG6729EJ0210 Rev.2.10
Jun.16.25
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3.5.1.2 stack_init

Figure 3.5 shows flowchart of stack_init in the loader program.

( stack_init >
Set the stack pointer for each proessor mode

Stack setting (System, FIQ, IRQ, Supervisor, Abort, Undefined).

FPU setting Set FPU operation permission.

Clock setting Set the clock.

Initialize variables with initial values and

Initialize variables used in the clear variables without initial value used in the program.
program
Update SYS_teQIW core clock Update system core clock variable to the current CPU frequency value.
variable

Initialize static constructor.

Initialize static constructor This process is required for C++ projects.

Port setting Set I/O port registers.

< hal_entry > Branch to hal_entry.

Figure 3.5 stack_init processing (loader program)
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3.5.1.3 hal_entry

Figure 3.6 shows flowchart of hal_entry in the loader program.

< hal_entry >

Disable port protection

Enable writing to registers related to 1/0 port.

Turn on LEDO Turns on LEDO to signal the start of copy processing.

Copy the applicationprogram to System SRAM

Copy application program from from external flash memory
external flash memory to RAM accoding to the parameters of loader table.
Turn on LED3 Turns on LEDS to signal the end of copy processing.

Enable port protection Disable writing to registers related to 1/0 port.

< app_prg > Branch to application program.

Figure 3.6  hal_entry processing (loader program)

R0O1AN6729EJ0210 Rev.2.10 Page 19 of 45
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3.5.2 Application Program
3.5.2.1 system_init

Figure 3.7 shows flowchart of system_init in the application program.

< system_init >

Set the offset of the exceptionvector table used
EL1 exception vector table offset in the application program.

setting

< stack_init > Branch to stack_init.

Figure 3.7  system_init processing (application program)
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3.5.2.2 stack_init

Figure3.8 and Figure 3.9 show flowchart of stack_init in the application program.

( stack_init >
Set the stack pointer for each proessor mode

Stack setting (System, FIQ, IRQ, Supervisor, Abort, Undefined).

FPU setting Set FPU operation permission.

Clock setting Set the clock.

Initialize variables with initial values and

Initialize variables used in the clear variables without initial value used in the program.
program
Update Sys'teQIW core clock Update system core clock variable to the current CPU frequency value.
variable
CPU MPU, cache setting Configure CPU MPU and cache.

Initialize static constructor.

Initialize static constructor This process is required for C++ projects.

Port setting Set I/O port registers.

()

Figure 3.8  stack_init processing (1/2)(application program)
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|

Semaphore setting

Configure semaphore function.

Master MPU setting Set Master MPU registers.

Global system counter setting Enable global system counter.

Initialize interrupt controller.
Interrupt setting

TFU setting Configure TFU.

< main > Branch to main, then branch to hal_entry.

Figure 3.9  stack_init processing (2/2)(application program)

R0O1AN6729EJ0210 Rev.2.10 Page 22 of 45



RZ/T2M Group  Example of separating loader program and application program projects

3.5.2.3 hal_entry

Figure 3.10 shows flowchart of hal_entry in the application program.

( hal_entry >

Software interrupt setting

Configure software interrupt (INTCPUOQ).

Generate software interrupt (INTCPUO).
After generating software interrupt,

G te soft int t . Lo
enerate software inferrup intcpu0_handler processing is executed.

Software delay Delay by software.

Figure 3.10  hal_entry processing (application program)
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Figure 3.11 shows flowchart of interrupt processing in the application program.

( intcpu0_handler >

Disable port protection Enable writing to registers related to 1/0 port.
Blink LED.
If LED is on, turn off LED.
Turn on/off LEDO and LED1 If LED is off, turn on LED.
Enable port protection Disable writing to registers related to 1/O port.

< return > Return to application main processing.

Figure 3.11 interrupt processing (application program)
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4. Related Documents

e User’'s Manual: Hardware
RZ/T2M Group User's Manual: Hardware
Download the latest version from the Renesas Electronics website.

Renesas Starter Kit+ for RZ/T2M
Download the latest version from the Renesas Electronics website.

e Technical Update/Technical News
Download the latest version from the Renesas Electronics website.

e User's Manual: Development Environment
The latest version for the IAR integrated development environment (IAR Embedded Workbench® for
Arm) is available from the IAR Systems website.
The latest version for the Renesas Electronics integrated development environment (e2studio) is
available from the Renesas Electronics website.
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5. Appendix Supplementary Notes on Development Environments

This section shows the steps up to the start of debugging of the sample program in each of the available
development environments. The following is an example using the xSPI0 boot mode version.

5.1

Debug procedure for this sample program.

5.1.1 EWARM from IAR systems

1.

Launch EWARM and open "RZT2M_bsp_xpiObootx1_app_loader.eww" with following procedure.
"[File] -> [Open Workspace] -> select Loader_application_projects\RZT2M_bsp_xpiObootx1_app_loader.eww"

Select "RZ/T2M_bsp_xspiOboot1_app" project in Workspace box as Figure 5.1.
And run build with "[Project] -> [Rebuild All]"

Then, select "RZ/T2M_bsp_xspiOboot1_loader" project in Workspace box.
And run build with "[Project] -> [Rebuild All]"

Make sure that your PC and RZ/T2M evaluation board are connected with I-jet.
Then, start debugging with "[Project] -> [Download and debug]"

After emulator connecting, both loader program and application program are downloaded to external
serial flash memory by Flash Downloader. After downloading is complete, the debugging is started
(Program starts running).

e RZT2M_bsp_xspilbootx1_app_loader - IAR Embedded Workbench IDE -
File Edit View Project |-jet Tools Window Help

11-;1; ﬁ .:

Workspace *+ 0 X

RZT2M_bsp_xspilbootx1_app - Releaze

RZT2M_bsp_xspilbootx1_loader - Debug

RZT2M_bsp =spilbootx]_loader - Release
[ P IR L T r] T,

rm ] D2 Tokd L Hal L | =L v
e
Eaiad S o ™=

Figure 5.1  Project selection
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NOTE: Select loader project when you start debugging as Figure 5.2.
Application program is already specified as extra image in loader project option.
"Right click loader project -> [Options...] -> [Debugger] -> [Images] -> [Download extra image]"

Options for node "RZT2M _bsp _xspiObootx1_loader” x

Category: Factory Settings

General Options ~
Static Analysis
Runtime Checking

C/C++ Compiler Setup Download Images Multicore Extra Options Plugins

Assembler
QOutput Converter
Custom Build Path: splication¥Debug¥Exe¥RZT2M_bsp_xspiObootx1_app.ouf
Build Actions '
Linker Offset: |0 [ Debug info only
Simulator [ Download extra image
CADI

CMSIS DAP
GDB Server
et
JLink/)-Trace
T1 Stellaris
Nu-Link

PE micro
ST-LINK Debug info only
Third-Party Driver

[ Download extra image

Debug info only

[ Download extra image

Cancel

Figure 5.2 EWARM option setting.
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5.1.2 e2studio from Renesas

1. Launch e2studio with your workspace. Then, click as following.
"[File] -> [Import...] -> [General] -> [Existing Projects into Workspace] -> [Next >]"

n

Select “[Select archive file]” and Browse "Loader_application_projects.zip".
Then, click "[Finish]"

3. Run build with "[Project] -> [Build All]"

4. Make sure that your PC and RZ/T2M evaluation board are connected with J-Link. Then, select
“RZ/T2M_bsp_xspiObootx1_loader” in connection setting and start debugging with "[Debug]"

5. After emulator connecting, both loader program and application program are downloaded to external
serial flash memory by Flash Downloader. After downloading is complete, the debugging is started
(Program starts running).

NOTE: Select the loader project when you start debugging. With the following debug configuration,
the loader program and application program are written to the external serial flash memory
at the same time when the loader project is connected for debug.

Debug Configurations [m] X

Create, and run ¢ g @
FeEx B8y~ Name: |RZT2M_bsp_xspi0bootx1_loader Debug_Flat

type filter text ||| 1 Main | % Debugger _ 1 Common| & Source
[E] C/C++ Application Initialization Commands e
[€] C/C++ Remote Application

[]Reset and Delay (seconds): 3
[JHalt

EASE Script
[€] GDB Hardware Debugging
[€] GDB OpenOCD Debugging
" GDB Simulator Debugging (RH850)
®1 Java Applet
[T Java Application Load image and symbols

h
.? Launch Gioup Filename Load type Offset (h.. On conn...
. Remote Java Application = = TORCE: 3 7o % Add..
+ [ Renesas GDB Hardware Debugging |l Program Binary | WP ICP | e ANt s
9 RZT2M_bsp_xspiObootx1_app Debug_Flat RZT2M_bsp_xspiObootx1_app.elf.. Image and Sy.. Yes
[7) RZT2M _bsp_xspiObootx1_loader Debug_Flat
[ Renesas Simulator Debugging (RX, RL78)
Runtime Options
[] set program counter at (hex):
Set breakpoint at: main
[J Resume
Run Commands
v
Filter matched 14 of 16 items Reyert Apply
Figure 5.3  Debug configurations in e2 studio
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5.2 Example of changing RAM placement in application program

The sample program copies the application program from the source address to the destination address
specified in the loader table. The user can change the placement of the application program by rewriting

the source and destination addresses as necessary.

5.2.1 EWARM from IAR systems

Below is an example (xspiOboot project) of changing the placement for application program from System

SRAM to ATCM.

fsp_xspi0_boot_loader.icf (Linker script for loader program)

Default

~en

/* Internal memory */

define region ATCM_region = mem:[from Ox00000000 size 128K];
define region BTCM_region = mem:[from Ox00100000 size 128K];
define region BTCM_LDR_region = mem:[from ©x00102000 size 56K];

define region APPLICATION_RAM_region = mem:[from 0x10080000 size 64K];

/* Flash memory */
define region LOADER_TABLE_region = mem:[from 0x60080000 size 64K];
define region APPLICATION_ROM_region = mem:[from 0x60100000 size 64K];

l

After changing
/* Internal memory */

define region ATCM_region mem: [from Ox00000000 size 128K];

define region BTCM_region = mem:[from Ox00100000 size 128K];
define region BTCM_LDR_region = mem:[from 0x00102000 size 56K];
define region APPLICATION_RAM_region = mem:[from 0x00000000 size 64K]; /* Change copy destination

address to ATCM */

/* Flash memory */
define region LOADER_TABLE_region = mem:[from Ox60080000 size 64K];
define region APPLICATION_ROM_region = mem:[from 0x60100000 size 64K];

~an

fsp_xspi0_boot_app.icf (Linker script for application program)

Default
place at start of SYSTEM_RAM_PRG_region { block PRG_WBLOCK };
place in SYSTEM_RAM_PRG_region { block USER_DATA_WBLOCK };
place in SYSTEM_RAM_PRG_region { block USER_DATA_ZBLOCK };
place in SYSTEM_RAM_PRG_region { rw data,

rw section .sys_stack,

rw section .svc_stack,

rw section .irq_stack,

rw section .fiq_stack,

rw section .und_stack,

rw section .abt_stack };
place in SYSTEM_RAM_PRG_region { rw section HEAP };~~~

After changing

~a~

place at start of ATCM_region { block PRG_WBLOCK }; /* Change code area to ATCM */
place in ATCM_region { block USER_DATA_WBLOCK }; /* Change data area to ATCM */
place in ATCM_region { block USER_DATA_ZBLOCK }; /* Change bss area to ATCM */
place in ATCM_region { rw data, /* Change stack area to ATCM */

rw section .sys_stack,
rw section .svc_stack,
rw section .irq_stack,
rw section .fiq_stack,

RO1AN6729EJ0210 Rev.2.10 Page 29 of 45



RZ/T2M Group  Example of separating loader program and application program projects

rw section .und_stack,
rw section .abt_stack };
place in ATCM_region { rw section HEAP }; /* Change HEAP area to ATCM */

~a~
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5.2.2 e2 studio from Renesas

Below is an example (xspiOboot project) of changing the placement for application program from System
SRAM to ATCM.

fsp_xspi0_boot_loader.ld (Linker script for loader program)

Default

~an

.IMAGE_APP_RAM 0x10080000 : AT (0x10080000)

IMAGE_APP_RAM_start = .;
KEEP(*(APP_IMAGE_RAM))

.IMAGE_APP_FLASH_section 0x60100000 : AT (©x60100000)

IMAGE_APP_FLASH_section_start = .;
KEEP(./src/Flash_section.o(.IMAGE_APP_FLASH_section))
IMAGE_APP_FLASH_section_end = .;

l

After changing

~an

.IMAGE_APP_RAM 0x00000000 : AT (0x00000000) /* Change copy destination address to ATCM */

{
IMAGE_APP_RAM_start = .;
KEEP(*(APP_IMAGE_RAM))

}

.IMAGE_APP_FLASH_section 0x60100000 : AT (©x60100000)

{
IMAGE_APP_FLASH_section_start = .;
KEEP(./src/Flash_section.o(.IMAGE_APP_FLASH_section))
IMAGE_APP_FLASH_section_end = .;

}

fsp_xspi0_boot_app.Id (Linker script for application program)

Default

.text 0x10080000 : AT (_mtext)
{

} > SYSTEM_RAM
.rvectors :

~on

} > SYSTEM_RAM
.ARM.extab :

{
} > SYSTEM_RAM
.ARM.exidx :

~rn

} > SYSTEM_RAM
.got :
{

} > SYSTEM_RAM
.data : AT (_mdata)

~rn

} > SYSTEM_RAM
.bss :

~ron

} > SYSTEM_RAM
.heap (NOLOAD) :

~r~
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{

} > SYSTEM_RAM
.thread_stack (NOLOAD):

~rn

} > SYSTEM_RAM
.sys_stack (NOLOAD) :

~rn

} > SYSTEM_RAM
.svc_stack (NOLOAD) :

~rn

} > SYSTEM_RAM
.irq_stack (NOLOAD) :
{

} > SYSTEM_RAM
.fig_stack (NOLOAD) :

~rn

} > SYSTEM_RAM
.und_stack (NOLOAD) :

~rn

} > SYSTEM_RAM
.abt_stack (NOLOAD) :

~ron

} > SYSTEM_RAM

~rn

~rn

~an

l

After Changing

.text 0x00000000 : AT (_mtext) /* Change code area to ATCM */
{

} > ATCM
.rvectors :

~on

} > ATCM
.ARM.extab :

~n

} > ATCM
.ARM.exidx :

~n

} > ATCM
.got :

~on

} > ATCM
.data : AT (_mdata) /* Change data area to ATCM */
{

} > ATCM
.bss : /* Change bss area to ATCM */

~on

} > ATCM
.heap (NOLOAD) : /* Change heap area to ATCM */

~n

~rn

} > ATCM
.thread_stack (NOLOAD):

~n

} > ATCM
.sys_stack (NOLOAD) : /* Change stack area to ATCM */
{
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} > ATCM
.svc_stack (NOLOAD) :
{

} > ATCM
.irq_stack (NOLOAD) :
{

} > ATCM
.fig_stack (NOLOAD) :
{

} > ATCM
.und_stack (NOLOAD) :
{

} > ATCM
.abt_stack (NOLOAD) :

~ron

} > ATCM
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5.3 How to Debug CPU1 Program

The sample program is CPUO single core operation with default configuration. The definition
"USE_CPU1" is added to the project options, and changing its value enables the program required to run
CPU1.

When CPU1 configuration is enabled, the Table 1 parameters in the loader table are replaced with the
information for copying the CPU1 program. The loader program refers to the parameters and copies the
CPU1 program in addition to the application program.

In addition, CPU1 reset release process is added to the application program. After the reset release
process is executed, CPU1 program runs from the beginning of System SRAM (0x1000_0000).

Detailed procedures for debugging CPU1 programs in each development environment are shown on
the following pages.
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5.3.1 EWARM from IAR systems

1. Build CPU1 program

Open the file “Loader_application_projects\cpu1\RZT2M_cpu1.eww” and build the CPU1 program.
The following project option settings will output build artifacts in raw binary.
After building the CPU1 program, close the RZ/T2M_cpu1.eww workspace.

Options for nodl”RZTZM,cqu” I X

Category: Factory Settings

General Options ~
Static Analysis
Runtime Checking

Output
CfC++ Compiler P
Assembler

Generate additional cutput

QOutput Converter
Custom Build Output format:
Build Actions P ey V
Linker
Debugger Qutput file

Simulator
CADI
CMSIS DAP RZT2M_cpul.bin
GDB Server

Iet

Jink/1-Trace

TI Stellaris

Nu-Link

PE micro

ST-LINK

Third-Party Driver v

Override default

Cancsl

2. Link CPU1 program to CPUO loader program
Add the following project option settings to link the CPU1 binary to the CPUOQ loader program.

Project for the loader program : [Options] -> [Linker] -> [Input]
Keep symbols : CPU1_SECTION

File : $PROJ_DIRS$\..\cpu1\Debug\Exe\RZT2M_cpu1.bin

Symbol : CPU1_SECTION

Section : CPU1_SECTION

Align 14
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Options for !‘IDI* "RZTZM_bsp_)(spiDbDDb(1_|Da\:|ErI X

Cateqgary: Factory Settings

General Options ~
Static Analysis
Runtime Checking . . " .
C/C4++ Compiler #define Diagnostics Checksum Encodings Extra Options
Assembler Config  Library  Input Optimizations ~ Advanced Qutput  List
QOutput Converter
Custom Build
Build Actions
Debugger
Simulator
CADI
CMSIS DAP
GDB Server
I4et
JHink/]-Trace
TI Stelaris
h {I.nk Eile: Symbol:  Section:  Align:
PE micro
STATK [$PROJ_DIRs¥. ¥application#Debug] [... | [APPLICAT| [APPLICAT ,4_|
Third-Party Driver v File:

Keep symbaols: (one perling)

" ECTION
CPLI_SECTION|

Raw binary image

Symbol: Section: Align:
|$PROJ_DIR$¥..¥cpu1¥Debug¥Exe¥F| (_PU1_SEC'||(_PU1_SEC‘

Carca

3. Enable USE_CPU1 definition

Activate the definition to run the CPU1 program. Change the value of "USE_CPU1" defined in the project
options of the loader program and the application program from 0 to 1.

- Project for the loader program
[Options] -> [C/C++ Compiler] -> [Preprocessor]: USE_CPU1=1
[Options] -> [Linker] -> [Config]: USE_CPU1=1

- Project for the Application program
[Options] -> [C/C++ Compiler] -> [Preprocessor]: USE_CPU1=1
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Options forn od:l" RZT2M_bsp_xspiOboot:1_load er"I X

Categary: Factory Settings

General Options ~ [ Multi-file: Cornpilation
Static Analysis Dizzard Unused Publics

Runtime Checking o
y Language 1 Language 2 Code Optimizations Output

List Preprocessor Diagnostics Encodings Extra Options

C++ Compiler

Assembler
Output Converter
Custom Build
Build Actions Additional include directories: (cne per ling)
Linker $PROJ_DIR%/rzt/arm/CMSIS_5/CMSIS/Core_R/Include ~
Debugger $PROJ_DIRS/rzt/fsp/inc

Simulator 3PROJ_DIRS/rzt/fsp/inc/api

CADT $PRO_DIRS/rzt/fsp/inc/instances

CMSIS DAP $PROJ_DIR%/r=t_cfg/fsp_cfg ]

GDE Server Preinclude file:
Ijet
J-ink/1-Trace
TI Stellaris Defined symbols: (one per ling)

Mu-Link LISE_CPLM :1| [J Preprocessor output to file
_ Rl Preserve comments
-RZT_CORE=CRS2_0 Generate #line directives

Dlgnore standard include directories

PE micro
STLINK
Third-Party Diriver

Cancel

Options forn 0d4" RZT2M_bsp_xspiObootx1_load er"I X

Categaory: Factory Settings

General Options ~
Static Analysis
Runtime Checking
CfC++ Compiler
Assembler

#define Diagnostics Checksum Encodings Extra Options
Config  Library  Input Optimizations ~ Advanced  Output  List

Output Converter Linker configuration file

Custom Build Override default
Build Actions

$PROJ_DIRS/ script/fsp_xspi0_boot_loadericf
Debugger

Simulator Edit..
CADI
CMSIS DAP Cenfiguration file symbel definitions: (one per ling)
GDE Server USE_CPU1:‘I|I
Iet
Jink/1-Trace
TI Stellaris
Mu-Link
PE micro
STLINK
Third-Farty Driver

T Bamn e

Carcel
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Options for nodl "RZT2M_bsp_xspidbootx1_app" I *
Celcams Factomy Settings
General Options ~ [ Multi-file Compilatior
Static Analysis Dizcard Unused Publicz
Runtime Chedking o

Language 1 Language 2 Code Optimizations Cutput

Assembler List Preprocessor Diagnostics Encodings Extra Options
Output Converter . ) .
Custom Build O Ignore standard include directories
Build Actions Additicnal include directories: (one per ling)
Linker $PROJ_DIR$/ rzt/arm/CMSIS_5/CMSIS/Core_RfInclude ~
Debugger $PROJ_DIRE/ rzt/fsp/inc

Simulator $PROJ_DIRE/ rzt/fsp/inc/api

CADI $PROJ_DIRS/rzt/fsp/inc/instances

CMSIS DAP $PROJ_DIRE/rzt_cfg/fsp_cfg e

GDE Server Preinclude file:

Iet |

J-Linkf1-Trace

TI Stellaris Defined symbols: (one per ling)

Mu-Link [ Preprocessor output to file

PE micro Preserve comments

STLINK Generate #line directives

Third-Party Driver v

Cancel
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4. Settings for debugging CPU1 project

To debug the CPU1 program, use EWARM's multicore debugging function. The following additional
project option settings enable debugging of CPU1 projects.

Project for the loader program: [Options] -> [Debugger] -> [Multicore]
Asymmetric multicore  : Enable “Simple”.
Partner workspace : $PROJ_DIRS\..\cpu1\RZT2M_cpu1.eww
Partner project :RZT2M_cpu1
Partner configuration  : Debug

Opticns for nodl"RZTZM_bsp_xspiDboobﬂ_Ioader" I *
e Factary Settings
General Options A
Static Analysis
Runtime Checking Multi - .

ulticore

C/C++ Compiler Setup Download Images Extra Options  Plugins

Assembler Symmetric multicore

Output Converter

Build Actions . .

Linker Asymmetric multicore

O Disabled
Simulator o :
CADI @®simple
CMSIS DAP Partner workspace: | $PROJ_DIR$¥. ¥cpul¥RZT2M_cpul.eww | -
GDB Server .
Lt Partner project: | RZT2M_cpul |
Iink1-Trace Partner configuration: | Debug |
T1 Stellaris
Nu-Link [ Attach partner to running target Partner cores:
i —

PEmicro O Advanced
ST-LINK
Third-Party Driver

Cancel

5. Rebuild and run the project

After rebuilding the loader program project, select "Download and Debug" to start debugging the loader
program.

During the debugging connection, workspace for the CPU1 project automatically opens as well.
Thereafter, CPUO and CPU1 projects can be debugged.
When the CPU1 program is executed, LED2 and LED3 blink.
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5.3.2 e2studio from Renesas
1. Build CPU1 program

Build the “RZT2M_cpu1” program. The following project option settings will output build artifacts in raw

binary.
&} Properties folR.ZTZM_cpu1 I [m| X
[type filter text | | settings G v §
Resource
Builders
w C/C++ Build Configuration: | Debug [Active] ~ | | Manage Configurations...
Build Variables
Environment
Logging 3 Tool Settings ) Toolchain 5 Device & Build Steps Build Artifact Binary Parsers @ ¢ | *
Settings
Tool Chain Editor (2 Target Processor Output file format (-(I) Raw binary ~ I
C/C++ General 2 Optimization [ Section: - text
Project Matures (# Warnings )
Project References (# Debugging L Section: 5 diata
Refactoring History v 83 Cross ARM GNU Assembler Other sections (-j) &
Renesas QF (2 Preprocessor
Run/Debug Settings @ Includes
Task Tags (2 Warnings
Validation @ Miscellanecus
w 83 Cross ARM C Compiler
(2 Preprocessor
(2 Includes
(# Optimization
(# Warnings
@ Miscellanecus
w B Cross ARM C Linker
@ General
@ Libraries
@ Miscellaneous Other flags @ ,D @
o Lo |
~ B Cross ARM GNU Create Flash Image
@ General
~ 83 Cross ARM GMNU Print Size
@ General
Restore Defaults Apply
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2. Link CPU1 program to CPUO loader program
Add a section definition to the linker script file to link the CPU1 binary to the CPUO loader program.

fsp_xspi0_boot_loader.ld (Linker script for the loader program)

SECTIONS
{
.IMAGE_APP_RAM 0Ox10080000 : AT (©x10080000)
{
IMAGE_APP_RAM_start = .;
KEEP (* (APP_IMAGE_RAM))
}
.IMAGE_APP_FLASH_section 0x60100000 : AT (0x60100000)
{
IMAGE_APP_FLASH_section_start = .;
KEEP(./src/Flash_section.o(.IMAGE_APP_FLASH_section))
IMAGE_APP_FLASH_section_end = .;
}
.IMAGE_CPU1_RAM 0x10000000 : AT (©0x10000000) /* CPUl program, RAM section for execution. */
{

IMAGE_CPU1_RAM_start = .;
KEEP(*(CPU1_IMAGE_RAM))

.IMAGE_CPU1_FLASH_section 0x60200000 : AT (0x60200000) /* CPUl program, ROM section. */

{
IMAGE_CPU1_FLASH_section_start = .;
KEEP(./src/Flash_section.o(.IMAGE_CPU1l_FLASH_section))
IMAGE_CPU1_FLASH_section_end = .;

}

.loader_param 0x60000000 : AT (©x60000000)

KEEP(*(.loader_param))
} > XSPIQ_CSO_SPACE
.flash_contents 0x6000004C : AT (©x6000004C)

{
_mtext = .;
. = . + (_text_end - _text_start);
_mdata = .;

. = . + (_data_end - _data_start);
flash_contents_end H
} > xSPIO_CSO_SPACE

N A A

}

IMAGE_APP_FLASH_section_size = SIZEOF(.IMAGE_APP_FLASH_section);
IMAGE_CPU1_FLASH_section_size = SIZEOF(.IMAGE_CPU1_FLASH_section);

)
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3. Enable USE_CPU1 definition

Enable the definition to run the CPU1 program. Change the value of "USE_CPU1" defined in the project
options of the loader program and application program from 0 to 1.

[Properties] -> [C/C++ Build] -> [Settings] -> [Tool Settings]
[Cross ARM GNU Assembiler] -> [Preprocessor]: USE_CPU1=1
[Cross ARM C Compiler] -> [Preprocessor]: USE_CPU1=1

Emvironment
Legging i Tool Settings 5 Toolchain %) Device # Build Steps Build Artifact Binary Parsers @] * | *
Settings
Tool C?‘IEII‘\ Editor @ Target Processor Use preprocessor
C/C++ General (% Optimization [ Do not search system directories (-nostdinc)
Project Natures % Warnings [ Preprocess only (-E)
Project References #% Debugging .
Renjesas QF v g Cross ARM GNU Assembler Defined symbels (-D) £ o 8
Run/Debug Settings (2 Preprocessor _RENESAS_RZT_
Task Tags (2 Includes _RZT_CORE=CR52.0
Validation (2 Wamnings
(2 Miscellanecus
~ 83 Cross ARM C Compiler
@ Preprocessor
(22 Includes
(2 Optimization
(& Wamnings
(£ Miscellaneous
~ 18 Cross ARM C Linker
(2 General
@ Libraries
(3% Miscellaneous Undefined symbols (-1} £
(2 Other I
Envircnment
Logging ) Tool Settings 8 Toolchain & Device & Build Steps Build Artifact Binary Parsers @[ * | *
Settings
Tool [gham Editor @ Target Processor Use preprocessor
C/C++ General (£ Optimization [ De not search system directories (-nostdinc)
Project Matures % Warnings [ Preprocess only (-E)
Project References £ Debugging .
Re:esas QE w g Cross ARM GNU Assembler Defined symbels (-D) &£ 8§
Run/Debug Settings (& Preprocessor RENESAS_RZT_
Task Tags (& Includes __CORE:CRSZ_U
Validation (£ Wamings

(2 Miscellaneous
w ) Cross ARM C Compiler
(2 Preprocessor
@ Includes
(& Optimization
(28 Warnings
(2 Miscellanecus
~ 35 Cross ARM C Linker
@ General
(& Libraries
(2 Miscellanecus Undefined symbols (-U) &)
(& Other |
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4. Rebuild and run the project

After rebuilding the loader program project, start debugging the loader program. The CPU1 program is
also written to flash memory at the same time during the debug connection.

8 Debug Configurations [m] X
Create, manage, and run configurations ﬁ

FeoERX| BT~ Name: [RZT2M_bsp_xspiObootu_loader Debug_Flat ]
[ype fiter et ||| (T Mam] % ebugger| > Startup| [ Common] &, Source

C/C++ Application

Project:
1] C/C++ Remote Application

EASE Script |RZT2M_bsp_xspidboot_loader Browse.
[5] GDB Hardware Debugging C/Ca+ Application:

GDB OpenOCD Debugging
[£¥ GDB Simulater Debugging (RHES0)
1 Java Applet Variables.. | | SearchProject.. | Browse..
71 Java Application
& Launch Group
[T, Remote Java Application Build Configuration: | Use Active v
v [E7 Renesas GDB Hardware Debugging
[c7] RZT2M_bsp_16bitbusboot_app Debug_Flat
7 RZT2M _bsp_iebitbusboot loader Debug_Flat ||| @ Use werkspace settings Configure Workspace Settings...
o] RZT12M_cpul Debug Flat
Renesas Simulator Debugging (RX, RL78)

| Debug/RZT2M_bep_xspivbootu 1 loaderatt

Build (if required) before launching

() Enable auts build () Disable auto build

Revert Apply
Filter matched 17 of 19 items.

When debugging the CPU1 program, start the debugging connection of the CPU1 project after making
the debugging connection of the loader program.

& Debug Configurations [m] X
Create, manage, and run configurations ﬁ\

FoRX BT~ Name: [RZT2M_cpu? Debug Flat |
[type fitter text ||| [T Main] % Debugger| g Startup| & source| = common

C++ Application Project:

€ Remote Application
& EASE Script |RzT2m_cput Browse..
GDB Hardware Debugging ©C++ Application:

[] GDB OpenOCD Debugging

[£9 GDB Simulator Debugging (RH850)
7 Java Applet Variables. Search Project...| |  Browse.
[T Java Application
@ Leunch Group.

| Debug/RZT2M _cpu.elf

Build (if required) before launching

T, Remote Java Application Build Configuration; |Use Active v
~ [T Renesas GDB Hardware Debugging
RZT2M_bsp_ t6bitbusboot_app Debug_Flat (O Enable auto build (O Disable auto build

[E7] RZT2M_bsp_16bitbusbaot_loader Debug_Flat ® Use workspace settings Configure Workspace Settings...
RZT2W_bsp_xspiObootx1_app Debug_Flat

iiliinbiimiciiaaiinlon de1 Debug Flat

[c7] RZT2M_cpu Debug_Flat

RX, RLTE)

Revert Apply
Filter matched 17 of 19 items

®@ I Debug I Close

When the following message is displayed, select "No".

& Launcher x

A Renesas GDB debug session is already active.

1N

Do you want to terminate all currently active debug sessions before starting the new
session? (Mote: Selecting Mo may result in unstable debug functionality)

[ Remember my decision

Yes Mo Cancel

If the debugging connection of the CPU1 project succeeds, CPUO and CPU1 are connected to the
debugger. Thereafter, CPUO and CPU1 projects can be debugged.
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By selecting Thread in the "Debug" view on the left side of the screen, the debug target core can be
switched between CPUO and CPU1.

B FSP_T2M_v120 - RZT2M_cpu/rzt/fsp/src/bsp/cmsis/Device/RENESAS/Source/startup.c - €* studio
Eile Edit Source Refactor Navigate Search Project RenesasViews Run Window Help

& || %= || ® ||4 Debug [ RZT2M_cpun Debug_Flat [mil @ rHiw |l @M IR
45 Debug X B % |i» B = O || RZT2M bspx.. |8 RZT2M bsp.x... [L] fsp_xspi0 bo... | [8) startup.c [ system.c
v E RZTZM, bsp xsplDbDDbd loader Debug F\at[Renesas GL 380

e ST RTT 382 ® * After boot processing, LSI starts executing here.[]

= BSP_TARGET_ARM void system_init (void)

X ot |oa
% Thread #11 {sln le core) [core o] (Susended Sic

= system_init() at startup.c:288 0x 103050

-ggg{ Thread for debugging CPUO

\__ arm-none-eabi-gdb (7.8.2) _ \n"
s Renesas GDB server (Host) MOVW  rB8, %[bsp_hactlr_bit_1] \n™ /* Set

~ [t RZT2M_cput DEbug_F\at[REnesas GDB Hardware Debu MOVT  r@, #@ An"
w B B7T2M cpuLe MCR pl5, #4, r@, cl, c@, #1 An™ /* Writ

ti[bsp_hactlr_bit_1] "i" (BSP_HACTLR_BIT_L) : "memory
@ Thread #11 smlecure core: 0] (Suspended : Si — - - - - -

= system_init() at startup.c:386 0x 10000040

889  Thread for debugging CPU1

S #if (8 == BSP_CFG_CPU)
__asm volatile (
"LLPP_access_enable: \n"

w arm-none-eabi-gdb (7.8.2) 4 \n"™
| Renesas GDB server (Host) 3 MRC  pl5, #4, rl, cl, cl, #@ AV Read
- 6 ORR  rl, rl, %[bsp_hcr_hcd_disable] \n" /* HVC
7 MCR pls, #4, rl, cl, cl, #2 \n™ /* Writ
8 t:[bsp_hcr_hed disable] "i" (BSP_HCR_HCD _DISABLE) :
g
@ 10008853 __asm volatile (
1 "set_vbar: An"
2 LDR ré, =_ Vectors An"
3 MCR  pls, #8, r@, cl2, c@, #2 \n" /T Write r@
4 "memory ") ;
2
1]
8
a

When the thread for debugging CPUO project is selected and the program is executed, the loader
program and the application program runs and LEDO and LED1 blink.

When the thread for debugging CPU1 project is selected and the program is executed, LED2 and LED3
blink.
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Revision History

Description
Rev. Date Page Summary

1.00 Nov.29, 2022 - First edition issued.

1.10 Jun. 15, 2023 - Modify behavior of loader program and application program.
- Support CPU1 operation.
4 Chang RZ/T2 FSP support version v1.0.0 -> v1.2.0
31 Add “Example of changing RAM placement in application

program”
1.20 Jul. 26, 2024 4 Change RZ/T2 FSP support version v1.2.0 -> v2.0.0

Change the version of the integrated development
environment.

- Deleted the mpu_cache_init function.

12. 13 | Change to Table 3.2, Table 3.3, and Table 3.5

17 Changed bsp_copy_4byte to bsp_copy_multibyte.

2.10 Jun. 16, 2025 14, 30 Change DATA_RBLOCK to USER_DATA_RBLOCK
Change DATA_WBLOCK to USER_DATA_WBLOCK
Change DATA_ZBLOCK to USER_DATA_ZBLOCK

31, 34 Removed instructions for placing sections in BTCM.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VL
(Max.) and Vi1 (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vix (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



Notice

1.

10.

11.

12.

13.
14.

(Note1)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters

TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
WWWw.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.

© 2024 Renesas Electronics Corporation. All rights reserved.
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